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Schoolhouse Fonts for Windows ~ Read Me 
 
 
Thank you for choosing vLetter, Inc.'s Schoolhouse Fonts. These TrueType fonts are perfect for making custom 
worksheets for teaching handwriting at any level. Each Schoolhouse Fonts Collection contains 18 fonts based on one 
of the two most commonly-taught handwriting styles in the U.S.: Zaner-Bloser©* style or D'Nealian®** style.  
 
Collection A (Zaner-Bloser© style)  Collection B (D’Nealian® style) 

cÑùÐÚ„•Ú…     cÑùÐÚ„•Ú… 
cursive   cursive 
printed     printed 
 
NOTE: Collection A font names begin with "SigA." Collection B font names begin with "SigB." 
 
Connected Cursive Style 
Each set includes 2 Connected Cursive fonts (with and without guidelines). Like real cursive handwriting, these 
fonts have variations in letter shapes and connections. Note: The connected cursive fonts require the use of the 
vLetter Toolbar for Word or the SigSoft Handwriter, two simple conversion utilities that are automatically installed 
with Schoolhouse Fonts. 
 
Cursive and Print Styles 
In addition, the sets have Print and Cursive fonts in many varieties: plain, bold, arrows, guidelines, arrows with 
guidelines, dotted, dotted with arrows, and dotted with guidelines. 
 
The sections Collection A and Collection B show samples of all fonts. All the fonts include characters commonly 
used in US English and most Western European languages. 

__________________________________________________________ 
* Zaner-Bloser© is a copyright of Zaner-Bloser, Inc. 
** D'Nealian® is a registered trademark of Donald N. Thurber and is licensed exclusively by Scott, Foresman and Co. 
 
 
 
 
********************************************* 
Installation: What Went Where 
The Schoolhouse Fonts installer will install all of the Schoolhouse Fonts into the Fonts folder, and adds a Program 
Group called "Schoolhouse Fonts" to the Start Menu. 
 
 
The Schoolhouse Fonts program group 
When you installed the Schoolhouse Fonts, a program group "Schoolhouse Fonts" was created in the Start Menu. 
This program group contains the following shortcuts: 
•  Schoolhouse Fonts Read Me.pdf - the file you are reading now.  
•  Schoolhouse User's Guide - a Help file for using Schoolhouse Fonts. 
•  vLetterPrintForm.pdf - the order form to get your own printing as a font.  
•  vLetterProForm.pdf - the order form to get your own handwriting as a font.  
•  vLetterSigForm.pdf - the order form to get your own signature as a font. 
•  SigSoft Handwriter - choose this to convert plain text into handwriting in many applications. 
•  vLetterWriter - choose this for writing notes and sending personalized eMail messages in handwriting. 
 
********************************************* 
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Choose Printed and Cursive fonts right from the Font menu! 
All of the included fonts, with 2 exceptions in each collection, may be used by simply choosing them in the font 
menu and typing the desired text. The excepted fonts have the word "Connect" in their font names. These fonts 
require the use of the vLetter Toolbar when using MS Word to convert text into these connected fonts, or the SigSoft 
Handwriter to convert text in many other applications. 
 
 
How to Use Connected Cursive Fonts 
SigAConnect, SigAConnectLn, SigBConnect, and SigBConnectLn require special conversion to connect their 
letters. These fonts can be used with the vLetter Toolbar in MS Word or the SigSoft Handwriter. Complete 
information regarding use of the SigSoft Handwriter is available from the "Help" menu, and from the Schoolhouse 
User's Guide. The basic steps for connecting the letters are described below. 
 
With the vLetter Toolbar: 
In MS Word, a Toolbar is installed which lets you apply the connected fonts to documents with just the click of a 
button. The Toolbar has 4 buttons: "ABC Handwriting" for converting the text, "ABC Plain Text" for undoing the 
conversion, "Signature" for signature, and "Settings" for changing your fonts. There is an animated demo of the 
Toolbar on the vLetter.com website at http://www.vLetter.com/support.htm#sstoolbar.  
1) Type some text using a plain font such as Arial or Times New Roman. 
2) Click the "Settings" button and choose your handwriting in the "Font" list. Then click "OK." 
3) Highlight the regular text you want converted to handwriting. 
4) Click the "ABC Handwriting" button. The connected font will appear.  
Note to Word 2002, 2003 (XP) users: You must click the Enable Macros button when you start Word. Our toolbar 
has a digital signature. Check the “trusted sources” checkbox upon opening Word. 
NOTE:  Do not check the option to "Use CSV mail merge syntax"; see page 10 for "Mail Merge Operations." 
 
SigSoft Handwriter – for Applications other than MS Word: 
1) Highlight the text you wish to see in connected handwriting. 
2) Open the SigSoft Handwriter (do not close your document). 
     Go to Start > Programs > Schoolhouse Fonts > SigSoft Handwriter. 
3) Choose your document's application in the SigSoft Handwriter's "Source" list (e.g. "WordPerfect"). 
4) Choose the connected font you want from the SigSoft Handwriter's "Font" list (SigAConnect or SigBConnect). 
5) Click the W (Write) button on the SigSoft Handwriter. 
NOTE: In some applications (e.g. WordPerfect 5 & 6; MS Works word-processing) there is an extra step involved 
in converting regular text into connected cursive. After step 5, above: 
6) Re-highlight the gibberish that appears in your document after you clicked the W (Write) button. 
7) Choose the same Schoolhouse Font from the application's font menu. The connected font should appear. 
 
 
Typing Spaces with Guidelines – Cursive and Printed 
For spaces with guidelines in lined fonts, add spaces using the accent key  `  (to the left of the number 1 key in the 
upper left-hand corner of the keyboard). Since this isn't a real character space, word processors may have trouble 
with word wrap when using these spaces with guidelines. It may be necessary to manually enter carriage returns 
where a line of text needs to be broken at the right-hand margin. 
 
 
Typing Multiplication and Division Symbols 
These characters are accessed by holding down the Alt key while typing the digits on the number pad on the right 
end of a standard keyboard. The Num-Lock key must be on. Notebook and laptops computers usually have a 
number pad embedded in the letter keyboard. See your laptop computer's documentation for instructions on how to 
access the number pad. 
 
 Character   Keystroke         
     ÷           Alt-0247 
     ×           Alt-0215 
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Collection A  (Zaner-Bloser© Style) 
 
I.  Schoolhouse A: Connected Cursive Fonts 
 
Font Name  Description 
SigAConnect  connected cursive 
SigAConnectLn  connected cursive with guidelines 
 
Important: These fonts are different from the other Schoolhouse Fonts. You must not choose the connected cursive 
fonts from the Font menu of your applications. These fonts require the use of the vLetter Toolbar for Word or the 
SigSoft Handwriter, two simple conversion utilities that are automatically installed with Schoolhouse Fonts. See the 
section on page 2, “How to Use Connected Cursive Fonts.” 
 
 SigAConnect 

ScÝÑ®þÝÑ´ÂÚ A cÑùÐÚ„•Ú… cÊÕÂŠËŸ¤ h‚Ð…˜±ŠË•ŠËÐÜ 
 
SigAConnectLn 

ScÝÑ®þÝÑ´ÂÚ`A`cÑùÐÚ„•Ú…`cÊÕÂŠËŸ¤`h‚Ð…˜±ŠË•ŠËÐÜ 
 
 
II.  Schoolhouse A: Cursive Fonts 
 
Font Name   Description 
SigACursive   cursive 
SigACursive-Bold  cursive (bold) 
SigACursiveArrow  cursive with arrows 
SigACursiveLine   cursive with guidelines 
SigACursiveArrowLine  cursive with arrows and guidelines 
SigACursiveDot   dotted cursive 
SigACursiveArrowDot  dotted cursive with arrows 
SigACursiveDotLine  dotted cursive with guidelines 
  
Note: You can access each of these cursive fonts from your word processor's Font menu. The bold version of your 
font can be accessed using the Bold Style command of your word processor. 
 
 
SigACursive 

abc 123 
 
SigACursive-Bold 

abc 123 
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SigACursiveArrow 

abc 123 
 
SigACursiveLine 

abc`123 
 
SigACursiveArrowLine 

abc`123 
 
SigACursiveDot 

abc 123 
 
SigACursiveArrowDot 

abc 123 
 
SigACursiveDotLine 

abc`123 
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III.  Schoolhouse A: Printed Fonts 
 
Font Name  Description 
SigAPrint  printed 
SigAPrint-Bold  printed (bold) 
SigAPrintArrow  printed with arrows 
SigAPrintLine  printed with guidelines 
SigAPrintArrowLine printed with arrows and guidelines 
SigAPrintDot  dotted printed 
SigAPrintArrowDot dotted printed with arrows 
SigAPrintDotLine dotted printed with guidelines 
 
Note: Access each of these printed fonts from your word processor's Font menu. The bold version of your font can 
be accessed using the Bold Style command of your word processor. 
 
 
SigAPrint 

abc 123 
 
SigAPrint-Bold 

abc 123 
 
SigAPrintArrow 

abc 123 
 
SigAPrintLine 

abc`123 
 
 

SigAPrintArrowLine 

abc`123 
 
SigAPrintDot 

abc 123 
 
SigAPrintArrowDot 

abc 123 
  
SigAPrintDotLine 

abc`123 
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Collection B  (D'Nealian®  Style) 
 
I.  Schoolhouse B: Connected Cursive Fonts 
 
Font Name  Description 
SigBConnect  connected cursive 
SigBConnectLn  connected cursive with guidelines 
 
Important: These fonts are different from the other Schoolhouse Fonts. You must not choose the connected cursive 
fonts from the Font menu of your applications. These fonts require the use of the vLetter Toolbar for Word or the 
SigSoft Handwriter, two simple conversion utilities that are automatically installed with Schoolhouse Fonts. See the 
section on page 2, “How to Use Connected Cursive Fonts.” 
 
SigBConnect 

ScÝÑ®þÝÑ´ÂÚ B cÑùÐÚ„•Ú… cÊÕÂŠËŸ¤ h‚Ð…˜±ŠË•ŠËÐÜ 
 
SigBConnectLn 

ScÝÑ®þÝÑ´ÂÚ`B`cÑùÐÚ„•Ú…`cÊÕÂŠËŸ¤`h‚Ð…˜±ŠË•ŠËÐÜ 
 
 
 
II.  Schoolhouse B: Cursive Fonts 
 
Font Name   Description 
SigBCursive   cursive 
SigBCursive-Bold  cursive (bold) 
SigBCursiveArrow  cursive with arrows 
SigBCursiveLine   cursive with guidelines 
SigBCursiveArrowLine  cursive with arrows and guidelines 
SigBCursiveDot   dotted cursive 
SigBCursiveArrowDot  dotted cursive with arrows 
SigBCursiveDotLine  dotted cursive with guidelines  
 
Note: Access each of these cursive fonts from your word processor's Font menu. The bold version of your font can 
be accessed using the Bold Style command of your word processor. 
 
 
SigBCursive 

abc 123 
 
SigBCursive-Bold 

abc 123 

SigBCursiveArrow 

abc 123 
 
SigBCursiveLine 

abc`123 
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SigBCursiveArrowLine 

abc`123 
 
SigBCursiveDot 

abc 123 

SigBCursiveArrowDot 

abc 123 
 
SigBCursiveDotLine 

abc`123 
 

 
 
III.  Schoolhouse B: Printed Fonts 
 
Font Name  Description 
SigBPrint  printed 
SigBPrint-Bold  printed (bold) 
SigBPrintArrow  printed with arrows 
SigBPrintLine  printed with guidelines 
SigBPrintArrowLine printed with arrows, guidelines 
SigBPrintDot  dotted printed 
SigBPrintArrowDot dotted printed with arrows 
SigBPrintDotLine dotted printed with arrows 
 
Note: Access each of these printed fonts from your word processor's Font menu. The bold version of your font can 
be accessed using the Bold Style command of your word processor. 
 
 
SigBPrint 

abc 123 
 
SigBPrint-Bold 

abc 123 
 
SigBPrintArrow 

abc 123 
 

SigBPrintLine 

abc`123 
 
SigBPrintArrowLine 

abc`123 
 
SigBPrintDot 

abc 123 
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SigBPrintArrowDot 

abc 123 
 

SigBPrintDotLine 

abc`123 
 

 
 
Getting Started 
These instructions assume you have already installed either Schoolhouse Fonts Collection A or Collection B.  
 
Use the cursive and printed style Schoolhouse Fonts as you would any font on your computer. You can access them 
from the font menu of your applications. NOTE: The connected cursive style fonts require the use of the vLetter 
Toolbar for Word or the SigSoft Handwriter, and must not be accessed from the font menu of applications like 
other fonts. See the next section on using the connected fonts. 
 
 
I.  How to Use the Cursive and Printed Fonts 
 
1. Go to the Font menu of the computer application that you usually use to create documents. 
2. Select a Schoolhouse Font. All Schoolhouse Font names begin with "SigA" (Zaner-Bloser© style) or "SigB" 

(D'Nealian® style). 
3. Select a font size. You will probably use the Schoolhouse Fonts at a larger point size than ordinary fonts. You 

can experiment with different sizes in each style you wish to use. 
4. Type text in a document. For fonts with guidelines, add spaces using the accent key  `  (to the left of the number 

1 key in the upper left-hand corner of the keyboard). 
 
 
II.  How to Use the Connected Cursive Fonts 
 
The Schoolhouse Fonts collections include connected cursive fonts (listed below). These fonts are different from the 
other Schoolhouse Fonts. You must not choose the connected cursive fonts from the Font menu of your applications. 
These fonts require the use of the vLetter Toolbar for Word or the SigSoft Handwriter, two simple conversion 
utilities that are automatically installed with Schoolhouse Fonts. See the section on page 2, “How to Use Connected 
Cursive Fonts.” 
 
Connected Cursive Fonts 
Zaner-Bloser™ style  D'Nealian® style 
SigAConnect   SigBConnect 
SigAConnectLn   SigBConnectLn 

 
 
vLetter Features 
 
Using Handwriting in a Regular Document (Non-Email Use) 
 
•  With the vLetterWriter: 
1. Open the vLetterWriter by double-clicking the shortcut on your desktop, or by going to Start > Programs > 
Schoolhouse Fonts > vLetterWriter. 
2. From the vLetterWriter "Handwriting" menu, choose "Handwriting Options." 
3. Select one of the handwriting styles listed in the "Handwriting" list and click "OK." 
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4. Click anywhere in the vLetterWriter window or hit any key to bring up the "Edit Window." 
5. Type some text directly into the "Edit Window," or copy and paste some text from another document. 
6. Click the "Click Here to View This Text as Handwriting" button. 
7. Choose "Copy (as Text)" or "Copy (as graphic)" from the "Edit Letter" menu. 
8. Put the cursor where you want the handwriting to appear in your document and choose Edit > Paste (if the text 
you pasted appears as symbols or Greek characters instead of handwriting, highlight those characters and select the 
correct handwriting style from the program's Font menu). 
•  To print handwriting directly from the vLetterWriter: 
Just go to File > Print in the vLetterWriter. The stationery or background color will not print, but the randomization 
of the baseline, word heights around the baseline, and the color of the handwriting will. NOTE: Dark backgrounds 
with light handwriting colors will not print: change the background to white and the handwriting to a dark color.  
 
 
•  With the vLetter Toolbar in Word: 
In MS Word, a Toolbar is installed which lets you apply the connected fonts to documents with just the click of a 
button. The Toolbar has 4 buttons: "ABC Handwriting" for converting the text, "ABC Plain Text" for undoing the 
conversion, "Signature" to insert a signature, and "Settings" for selecting your fonts. There is an animated demo of 
the Toolbar on the vLetter.com website at http://www.vLetter.com/support.htm#sstoolbar.  
 
1) Type some text using a plain font such as Arial or Times New Roman. 
2) Click the "Settings" button and choose one of the Connect fonts in the "Font" list. Then click "OK." 
3) Highlight the regular text you want converted to a Connect font. 
4) Click the "ABC Handwriting" button. The text is converted to the connected font.  
 
Note to Word 2002, 2003 (XP) users: You must click the Enable Macros button when you start Word. Our Toolbar 
has a digital signature. Check the “trusted sources” checkbox upon opening Word. 
 
NOTE:  Do not check the option to "Use CSV mail merge syntax" unless you are converting text in a .CSV file. 
             See the section on page 10: "Using Handwriting in Mail Merge Operations." 
 
 
•  With the SigSoft Handwriter – for Applications other than MS Word 
1) Highlight the text you wish to see in connected handwriting. 
2) Open the SigSoft Handwriter (do not close your document). 
     Go to Start > Programs > Schoolhouse Fonts > SigSoft Handwriter. 
3) Choose your document's application in the SigSoft Handwriter's "Source" list (e.g. "WordPerfect"). 
4) Choose the connected font you want from the SigSoft Handwriter's "Font" list (SigAConnect or SigBConnect, or 
LiteUS or LiteEuro). 
5) Click the W (Write) button on the SigSoft Handwriter. 
 
NOTE: In some applications (e.g. WordPerfect 5 & 6; MS Works word-processing) there is an extra step involved in 
converting regular text into connected cursive. After step 5, above: 
6) Re-highlight the gibberish that appears in your document after you clicked the W (Write) button. 
7) Choose the same font from the application's font menu. The connected font should appear. 
 
 
Using Handwriting in Emails 
(more details are available on our website's Help page at http://www.vletter.com/support.htm) 
 
A. Send an Email message directly from the vLetterWriter: 
1. Open the vLetterWriter from the Start menu (Start > Programs > Schoolhouse Fonts > vLetterWriter) or from 
the shortcut on your Desktop. 
2. Hit any key to begin typing in the Edit Window. When finished, add one or two hard returns. 
3. Click the "Click Here To VIEW THIS TEXT AS HANDWRITING" button, or click in the vLetterWriter's main 
window. If the handwriting that appears is not the one you wanted, choose the correct handwriting from the 
vLetterWriter's Handwriting > Handwriting Options menu. 
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4. Choose items from the Handwriting, Colors, and Stationery menus to customize your vLetter if you wish. 
5. Choose "Send this vLetter to..." from the eMail menu.  
NOTE: The first time you send email directly from vLetter, you may be asked to put the name of your SMTP 
(outgoing) mail server into the Settings box. Don't be alarmed; this is usually just the name of your ISP with "mail." 
in front of it. If you are using Outlook or Outlook Express for email, the SMTP server name should be selected 
automatically when you use the vLetterWriter. For most other users, this will be their email return address with 
"mail." or "mailhost." in place of  their names. For example, if you are "johndoe@gorge.net", try using 
"mail.gorge.net" as the SMTP). 
6. Choose the name of your recipient in the "Send To:" box; enter a "Subject," and enter your name. Check the 
"Send a copy to my own eMail address" option if you want to see what the vLetter email looks like, and check "Tell 
recipient about vLetter.com" if you want to send them a link to our website. 
7. Click the "Send" button and a few seconds later you'll be notified that your email has been sent! 
** NOTE: This procedure will send your email message as an attached image. If you want to send it as HTML, 
choose this option in the vLetterWriter's eMail > Settings menu. The HTML message may be sent as an attachment 
anyway to recipients with older email applications and to AOL users. 
 
B. Put handwriting into regular Email messages: 
1. Open the vLetterWriter from the Program menu or Desktop shortcut. 
2. Hit any key to begin typing in the Edit Window. When finished, add one or two hard returns. 
3. Click the "Click Here To VIEW THIS TEXT AS HANDWRITING" button, or click in the vLetterWriter's main 
window. If the handwriting that appears is not the one you wanted, choose the correct handwriting from the 
Handwriting menu. 
4. Choose items from the Handwriting, Colors, and Stationery menus to customize your vLetter if you wish. 
5. From the eMail menu, choose "Convert this vLetter to an eMail attachment."  Enter a name when prompted; it 
will be saved as a GIF image on your desktop. 
6. Attach the image on your desktop to an email message. The recipient's email application will usually 
automatically display it when they open the email message (in some email applications, the recipient may need to 
double-click the attachment to see the image). 
** NOTE: You cannot edit this GIF; if you want to save an editable vLetter, choose vLetter's File > Save As option. 
The file you save will have a ".vlt" extension and will open in vLetterWriter when you double-click it. To send an 
email from an opened, editable vLetter (with .vlt extension), first go to vLetter's eMail menu, then Send it directly or 
Convert it into a .GIF. 
 
 
Using Handwriting in Mail Merge Operations 
•  You can use vLetter software to perform small mail merges in Microsoft Word or other applications. 
•  If you have more than 5000 names on your mailing list, you need a special license agreement. Send an email to 
service@vletter.com, or visit http://www.vletter.com/direct_postal.htm for more information. 
•  vLetter products can be used for mail merging, but first, text in the chosen fields in the database must be converted 
into handwriting. We recommend that you first make a copy of your database, then do all work in that copy. The 
exact sequence of steps for converting text in your database prior to mail merging is different for each application. 
Visit http://www.vletter.com/support.htm#mailmerge for steps on using vLetter products with Mail Merge. 
•  Microsoft Word users: You can download a free step-by-step PDF guide for doing mail merges in Word. These 
instructions are specific to Word XP, but the steps are the same or similar for other versions of Word: 
 http://www.vLetter.com/downloads/mailmergeXP.pdf 
 
 
Font Menus 
Some applications have optional WYSIWYG font menus in which the name of each font is displayed in the 
corresponding font. Because Schoolhouse Fonts have guidelines, arrows, dots and other special features, they are 
sometimes difficult to read in these menus. You may prefer to turn this option off. In Microsoft Word, go to Tools > 
Customize. Go to the Options tab, then uncheck the option to "List font names in their fonts." Then click Close. 
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Accented Characters and non-English Symbols  
Schoolhouse Fonts include most of the accented characters and much of the punctuation and symbols common to 
Western European languages (Spanish, French, German, etc.). The accented characters are accessed in the same 
manner as they are accessed in regular fonts such as Arial or Times New Roman. For using the two Connected fonts 
in the set, type the foreign characters in Arial or Times first, then convert the text to one of the Connected fonts 
using the vLetter Toolbar or the SigSoft Handwriter (see page 2 or page 9). 
 
For those of you new to using accented characters, the following table shows the keystrokes needed to access all the 
accented characters included in the Schoolhouse Fonts. For example, if you are writing "mañana", you would type 
"maAlt-0241ana". Hold the "Alt" key while you type 0241 from the number pad on the right side of the keyboard 
(or the embedded number pad on most laptops), with Num Lock on. 
 
Character/Keystroke        Character/Keystroke  Character/Keystroke        Character/Keystroke 
á Alt-0225 
Á Alt-0193 
à Alt-0224 
À Alt-0192 
â Alt-0226 
Â Alt-0194 
ã Alt-0227 
Ã Alt-0195 
ä Alt-0228 
Ä Alt-0196 
å Alt-0229 
Å Alt-0197 
æ Alt-0230 
Æ Alt-0198 
ç Alt-0231 
Ç Alt-0199 

è Alt-0232 
È Alt-0200 
é Alt-0233 
É Alt-0201 
ê Alt-0234 
Ê Alt-0202 
ë Alt-0235 
Ë Alt-0203 
ì Alt-0236 
Ì Alt-0204 
í Alt-0237 
Í Alt-0205 
î Alt-0238 
Î Alt-0206 
ï Alt-0239 
Ï Alt-0207 

ñ Alt-0241 
Ñ Alt-0209 
ò Alt-0242 
Ò Alt-0210 
ó Alt-0243 
Ó Alt-0211 
ô Alt-0244 
Ô Alt-0212 
õ Alt-0245 
Õ Alt-0213 
ö Alt-0246 
Ö Alt-0214 
ø Alt-0248 
Ø Alt-0216 
ù Alt-0249 
Ù Alt-0217 

ú Alt-0250 
Ú Alt-0218 
û Alt-0251 
Û Alt-0219 
ü Alt-0252 
Ü Alt-0220 
ÿ Alt-0255 
Ÿ Alt-0159 
ß Alt-0223 
§ Alt-0167 
ª Alt-0170 
° Alt-0176 
¥ Alt-0165 
£ Alt-0163 
¿ Alt-0191 
¡ Alt-0161 

 
 
How to Order Your Own Handwriting 
1. Open the "vLetterProForm.pdf" from the Schoolhouse Fonts program group. It requires the free Adobe(R) 
Acrobat Reader, available at http://www.adobe.com/products/acrobat/readstep2.html. 
2. Print the forms. 
3. Read the instructions carefully, then fill out the Order Form and appropriate sample form. The "US Form" is for 
those who write in US English. The "Euro Form" is for those who write in Western European languages such as 
French, Spanish, German, Italian, Swedish, etc.  IMPORTANT: Use a pen that makes a smooth, dark line, such as a 
rollerball, fountain or fibertip pen. 
4. Name your handwriting using 3-7 alphabetic characters (no numbers or punctuation), e.g. Ronfont or Suehand. 
Don't use a name that is the same as any of the fonts on your system. 
5. Choose the Rush Processing option if you wish to have your order processed in business 5 days (normal 
processing is 3 weeks). 
6. Choose the Shipping method you prefer (free via email download, or shipped on CD for all other options). Be 
sure to include your email address if you want it shipped via email. 
7. Provide credit card information for payment, or enclose a check or Purchase Order form for the total amount due. 
8. Send us the form and payment by Mail or Email. 
 
   Mail (ensures the best results) 
   vLetter, Inc. 
   509 Cascade, Suite H 
   Hood River, Oregon  97031 
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   Email (next best results) 
  1) Scan the forms as follows: 300dpi as Black & White Line Art (no color, no grayscale, no half-tone), at 100% 
size. We cannot process color or grayscale. Scans must be 300dpi. Important: place the form in your scanner 
with the TOP of the form aligned with the TOP of the scanner glass. 
  2) Review your scan to make sure it is dark enough. Check for gaps in letters, or loops which do not close in the 
scan, but which do close on the form. If you find such errors, rescan at a darker setting (tone or gamma adjustment). 
  3) Save the scan in one of the following file formats: .PCT, .PCX or .TIF. Give the scan the same name as your 
font. You can compress the scanned file using PKZip or DropStuff for speedier transmission. 
  4) Attach the scanned file to your email message. Send the email to service@vletter.com. We will respond to your 
email and inform you if we can use the scan or if you need to rescan it and send it again. 
 
 
How to Order Your Own Printed Writing or Your Own Signature 
1. Open the vLetterPrintForm.pdf for your own printing as a font, or open the vLetterSigForm.pdf for your own 
signature as a font. 
2. Follow the instructions on the form, and submit the form to us, with payment, via Mail or Email for processing 
(see instructions above). 
 
 
 
Site and District Licenses 
Each single copy of Schoolhouse Fonts can be installed on only one machine. If you plan to use Schoolhouse Fonts 
on more than one machine or on both Mac and Windows platforms, you should consider purchasing a site license. 
With a site license, you may install Schoolhouse Fonts on as many  machines as you like at a single site location. 
(For District-Wide licensing, please contact us at 541-387-2800.) 
 
Schoolhouse Fonts Site License: $249.95  to install on an unlimited number of computers (single platform) at a 
single school address. (Call for a quote on a district-wide multiple site licenses.)  Purchase Orders gladly accepted. 
Shipping:  Free download via email; $10.00 for CD via US Priority Mail. 
 
 
System Requirements:  
Macintosh: OSX (OS9 available by request)  
Windows: 98 or later (including XP) 
Hardware: Internet connection for software download, or CD drive to install from CD 
 
 
Website: www.SchoolhouseFonts.com 
Tools for creating custom worksheets and teaching handwriting at school or home. Free downloadable demo.  
 
Website: www.vLetter.com 
Visit the vLetter website for complete information about our handwriting software for computers, and about 
upgrading your Signature Software products to vLetter®. There are samples of vLetters, a free vLetter demo to 
download, an online version for sending free handwritten emails to friends and colleagues, and more. 
 
 
vLetter.com Tech Support 
Email:  service@vLetter.com 
Phone:  541-387-2800 
Fax:  503-296-2429 
Website:  http://www.vLetter.com/support.htm 
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Contact Us 
vLetter, Inc  
509 Cascade, Suite H 
Hood River, OR 97031 
Phone:  541-387-2800 
Fax:  503-296-2429 
Email:  service@vletter.com 
 
 
 
To Remove Schoolhouse Font Files 
Go to Start > Settings > Control Panel > Fonts. Delete the 18 font files that start with SigA or SigB, and the fonts 
named Demo1, LiteUS and LiteEuro. 
 
To Remove Installed Items 
The vLetter installer created the following folders and files. To uninstall the program, delete the underlined files 
and/or folders and restart your computer. 
 
C:\   Program Files folder: 
   vLetter  (folder) 
    
       Windows folder: 
  vLetterMail450.dll 
  vLetter.gif 
  vLetter.ini 
  vLetter.adr 
    
       Windows\system32  folder: 
  HWDLLN32.dll 
 
        Desktop folder: 
  vLetterWriter  (shortcut) 
 
        Start Menu folder: 
  Programs\ 
   Schoolhouse Fonts  (folder) 
   vLetter  (folder) if present 
 
        Windows\Temp folder: 
  vLetter  (folder) 
 
 
If you have Microsoft Office or Word (this location may vary): 
C:\Program Files\Microsoft Office\Office\Startup  folder  (also check Office10 and/or Office11 if present): 
  vLetter.dot     (this is the vLetter Toolbar for Word) 
 
 
Restart your computer. 
 


